
2 - 1

USER'S GUIDE

Chapter 2
GUIDED TOUR

Readiris is a state-of-the-art OCR package equipped with numerous advanced
features. We will discuss all major features in this chapter and add many tips and
hints concerning the use of Readiris.

STARTING THE SOFTWARE UP

Click on the Readiris application in the submenu "I.R.I.S. Applications -
Readiris", or click on the shortcut to the Readiris application on your desktop.

The Readiris startup screen and application window are displayed. The startup
screen displays the version and copyrights of the Readiris software. It also gives
direct access to I.R.I.S.' home page - simply click on the URL to visit I.R.I.S.'
web site. Clicking the mouse anywhere else makes this screen disappear.
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The next window concerns the OCR wizard; click "Cancel" for the time be-
ing.

THE FIRST-TIME STARTUP

Depending on the software bundle you acquired, the first startup may be spe-
cial: you may be prompted to register your licence.

If this is the case, the use of Readiris is limited to 30 days, and by registering,
you receive a free softkey from I.R.I.S. to continue using the software after the
first month.

It takes your identification number to generate the softkey; be sure that this
number is available or mentioned when you register your licence.
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DISCOVERING THE READIRIS INTERFACE

The Readiris application window not only contains command menus but also
two button bars that give quick access to all frequent commands. Initially, some
command menus are dimmed: they concern the preview. As long as no image is
opened, they are unavailable.
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The same goes for the image toolbar on the right side of the application
window: it contains all commands you need during the image preview. The main
toolbar on the left gives quick access to all frequent general commands.

To learn which command corresponds to a certain button, hold your mouse
pointer over it for a while: a tooltip will tell you what the button does.
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The window pane or image zone is where the scanned images are displayed.
You can drop image files onto the image zone to recognize them.

As soon as pages gets processed, an additional toolbar, the page toolbar, is
added below the image zone: it represents the various pages of the document and
gives access to the page commands using the right-click (the "Context" menu).

GETTING STARTED WITH A FIRST TUTORIAL

The best way to become familiar with the operation of Readiris is undoubtedly
by using it. A number of prescanned images is provided with the software;
they allow you to get started even when there is no scanner connected to your
computer. Let’s turn to these now.

The "Source" button on the main toolbar determines whether you are going to
use a scanner or a prescanned image as image source.

Color, greyscale and black-and-white images are supported on an equal basis.
Readiris allows you to open JPEG images, Paintbrush (PCX) images, TIFF im-
ages (uncompressed, PackBits, Group 3 and Group 4 compressed), multipage
TIFF images and Windows bitmaps (BMP).

This capability is particularly useful to convert your faxes into editable text
files.



2 - 6

As you are going to open a prescanned image, you should select the disk, and
not the scanner, as image source with the "Source" button.

      

Next, click the "Open" button. (When you select the disk as image source, the
"Scan" button is replaced by the "Open" button and the corresponding "Scan"
command under the "Process" menu is replaced by the "Open" command.)

      

You could also select the command "Open" from the "File" menu and open a
prescanned image directly - this works even if your scanner operates as current
image source.

You are invited to select an image file. Select the file ENGLISH.JPG in the
Readiris folder. As this sample file is a color image, it is not only read from disk:
a “binarized”, black-and-white version is created for the OCR process.

       

Finally, the image is displayed in the image zone. The page toolbar indicates
that a single page is loaded into Readiris.
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A third way of opening prescanned images is the use of “drag and drop”:
drag images from the Windows Explorer onto the Readiris image zone and they
are promptly opened.

Finally, you can open images from within the Windows Explorer: right-click
an image file and select the command "Recognize" from the "Context" menu.
(This command only appears when the file's filetype is supported.)
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That does not mean the OCR is promptly executed: to give the user full flex-
ibility, Readiris is simply started up and the image is opened.

The image toolbar on the right side of the Readiris application window con-
tains all commands you need during the image preview: tools to indicate the zones
of interest, to rotate the image, zoom in and out etc.

ZOOMING IN ON IMAGES

Readiris has several commands that allow you to zoom in on a scanned im-
age, for instance to verify the scanning quality.

The image toolbar contains buttons that allow you to zoom in at real size, to fit
the image to the page width and to fit the entire image in the preview window.
The "View" menu contains the same commands and adds two extra zoom levels:
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you can display the image at 50% and 200% of its actual size. At actual size, a
screen pixel corresponds to an image pixel. (Shortcuts are available for all zoom
levels!)

                

Finally, you can right-click the mouse button over a region of the scanned
image to zoom in at real size immediately. Right-click a second time to zoom out
again.
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ONE, DECOMPOSING A SCANNED IMAGE

Now that the image is scanned, you have to indicate which parts you want to
convert into editable text by drawing frames, so-called “windows”, around the
zones of interest.

Actually, Readiris will do this for you automatically when the option "Page
Analysis" is enabled on the main toolbar.
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Automatic page decomposition is particularly useful when columnized texts
and documents with a complex page layout, possibly including graphics and tables,
are recognized.

Page decomposition uses three window types: text, graphic and table win-
dows. Readiris discriminates text blocks, tables and graphic zones containing
photos, illustrations etc. on the page. (Saving graphics and recognizing tables will
be discussed at great length below.)
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A color code indicates the window type: text zones are yellow, tables are
purple. Graphic windows have a blue border but no “fill” color - it would be a
shame to mask the actual color tones of the graphic.

The number of windows is indicated at all times in the tooltips of the "Text
Window", "Graphic Window" and "Table Window" tools.

                  

Page analyisis is fast, skew-tolerant and highly accurate: it traces complex,
“irregular” shapes.

The page analysis will even detect zones where you get white text on a
black background. Recognizing such inserts is no problem: while the preview
displays the scanned document correctly on-screen, Readiris “inverts” the image
when the need arises to recognize such text blocks! (You can have your scanner
generate fully inverted images to process pages with white text on a black back-
ground. See below.)

ONE AND A HALF, SORTING WINDOWS

Readiris not only detects the various blocks, but also sorts them: the zones are
sorted top-down, left to right by default to cope with columnized documents.

Evidently, you can modify the sort order. To do so, click the "Sort" button on
the main toolbar. The mouse cursor becomes a pointing hand as soon as the “sort
mode” is enabled.



2 - 13

USER'S GUIDE

Click on the windows you want to include. Windows you do not click on are
simply ignored, excluded from recognition. It's easy to see which windows are
selected and which aren't: the selected windows have their full color, non-se-
lected windows have a lighter color tone.
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Page analysis is enabled by default. To force Readiris to decompose the cur-
rent page - because you disabled page analysis by accident, because you erased
some windows erroneously and want to redo the page analysis etc. -, you can
simply click the button "Analyze Page" in the image toolbar.

(Select the document language before executing the page analysis when you
are dealing with Asian documents. Specific routines are used for these languages:
the interline spacing of Asian documents is in most cases bigger than in Western
documents, the text is made up of small icons (“ideograms”) that could easily be
seen as graphic zones in Western documents and the text may run from top to
bottom, from right to left.)

TWO, WINDOWING A SCANNED IMAGE MANUALLY

Page analysis is the automatic way of windowing a scanned page. Alterna-
tively, you can zone an image manually with the windowing tools of Readiris.

To draw a rectangle around a zone of interest, select the corresponding tool in
the image toolbar, click the cursor in the upper left corner of the window, stretch
the window by moving the mouse to the lower right corner and click again. (Sides
smaller than 1 mm are not allowed, they wouldn't even contain a single character
anyway.)
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The windows are automatically sorted in the order of creation: arrows indi-
cate the sort order.

You can also frame “irregular” text blocks by drawing polygonal windows
around them. Non-rectangular windows are created by merging rectangular zones:
as soon as two rectangles (of the same type) intersect, they become a single
window automatically! In a way, you're building a house by adding one room
after the other... (Creating polygonal table windows doesn't make any sense.)

Furthermore, manual windowing can be combined with window sorting: you
can draw new windows even when the “sort mode” is enabled. You then use
sorting to include a number of detected windows and manually create some other
windows where the page analysis didn't yield the appropriate results. As soon as
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you start creating windows in the “sort mode”, all windows you didn't select are
promptly erased!

To modify, move and delete windows, you need to select them first. To do so,
select the "Window Selection" or “arrow” tool in the image toolbar and click
inside a window. Rectangular markers now appear at each corner and in the
middle of the window sides.

           

To unselect windows, click the mouse button elsewhere. To select addi-
tional windows, hold down the Shift key while clicking on these extra windows.
To select a window and the included windows (of another type), hold down the
Ctrl key while clicking on the main window.

You can display the type, pixel coordinates and sort order of a window by
pressing the Alt key while you select it!
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So much for selecting windows. To modify a window, select it, put your mouse
cursor over a marker and drag the side to change the window size.

To move a window, simply select it and drag it to another location.

To delete windows, select the window(s) and choose the "Cut" or "Clear"
command from the "Edit" menu. The "Cut" command cuts the window(s) to an
internal buffer, "Clear" erases the window(s) irretrievably. When you paste win-
dows, they are inserted in their original position, and you have to drag them to
their new location.

In fact, all familiar commands from the "Edit" menu apply to the windows:
you can delete, cut, copy and paste them! The "Undo" command also applies: if
you have unfortunately deleted, moved, resized etc. some windows, "Undo" will
cancel the last operation.

Also note that shortcuts are available for all commands! Let's give an ex-
ample: to erase all existing windows, you can choose the command "Select All"
or its shortcut Ctrl+A and click the command "Clear" or its shortcut Delete. You
are now ready to recreate the necessary layout. To restore the previous layout,
you can choose "Undo" or the shortcut Alt+Backspace.
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THREE, SAVING WINDOWING TEMPLATES

The resulting windowing layouts can be saved as zoning templates for fu-
ture use with the command "Save Layout" under the "File" menu and loaded into
memory with the command "Load Layout".

If you have to recognize documents with a similar layout, for instance a 50
page report where the header and footer should be excluded for obvious reasons,
a single template can be applied to zone all 50 pages.

When you load a template into memory, page analysis is disabled automati-
cally. The zoning template remains active until you re-enable page analysis on the
main toolbar.

READIRIS TAKES YOU AROUND THE WORLD

Assuming that the windows are correctly defined, you are now almost ready
to execute the character recognition. We say “almost”, because we haven’t veri-
fied the language and document settings yet.

The language setting can be found on the main toolbar.

Click the "Language" button to modify the document language.
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You can press a letter key to move to it directly: if English is currently se-
lected, and you want to select Hungarian, you can click the "H" key on your
keyboard to go directly to the Hungarian language. When several languages have
the same initial, press the letter several times to go through the options. Let's give
an example: Readiris reads Polish and Portuguese. By pressing "P" once, you
select Polish, by pressing "P" a second time, you select Portuguese, and by press-
ing "P" a third time, you're back on Polish. (To go to another letter, say T, press
BackSpace before you enter the "T" character.)

Readiris is far from limited to English: up to 56 languages are supported! All
American and European languages are supported, including the Central-Euro-
pean languages, Greek, Turkish, the Cyrillic (“Russian”) and the Baltic languages.

Optionally, you can read Asian documents: the extra module “Asian OCR
add-on” offers recognition of Japanese and Simplified Chinese. Traditional Chi-
nese is not supported. (Simplified Chinese is used on China’s mainland, where
Traditional Chinese is used by the “Big 5” communities - Hong Kong, Taiwan,
Singapore etc.)

Also note that the British and American - or should we say “international”? -
variants of the English language are distinguished.

It takes the appropriate Windows configuration to display Central-European,
Greek, Turkish, Cyrillic and Baltic characters. You may have to install the Win-
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dows “service pack” "Multilanguage Support" before your Windows system is
able to cope with these languages. Select the icon "Add/Remove Programs" un-
der the "Control Panel" to find out if this Windows module is installed  on your
PC. Depending on the software bundle you acquired, the Readiris CD-ROM
may contain detailled information on how to install this Windows module.

To view and edit Asian documents, you can install an Asian, Japanese or
Chinese version of the Windows operating system or run specialized “emulating”
software (such as UnionWay AsianSuite or TwinBridge AsianBridge) on a West-
ern version of Windows to correctly represent the ideograms of these Asian
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languages. Finally, you can use Word 2000 to view and edit such documents:
Office 2000 was specifically designed to cope with documents in many different
languages.

Selecting the proper document language is imperative. Based on the selection
of a language, the software knows which symbol set to recognize. Multi-linguis-
tic support ensures that “exotic” characters such as ç, ß, ñ, γ and ø are recog-
nized correctly.

Secondly, the software extensively uses linguistic databases to validate its
results. Suppose that you have to read the word "president" where an ink stain
makes the "r" look like an "f". Looking things up in the English lexicon, Readiris
will detect autonomously that the word "president" is being read and that it doesn't
make any sense to recognize the symbol "f". This “self-learning” technique is
of course highly dependant on the linguistic context.

Linguistics offer useful help to solve ambiguous cases such as an "O" which
might be mistaken for a '0'. Another typical example is the letter "l" and number
'1' which have an identical form in many fonts - think of texts produced on old
typewriters! The linguistic context helps to determine whether you are dealing
with "l" or '1'.

The illustration below shows various shapes of '1' and "l". The shapes on the
first line are unambiguous, the shapes on the second line are ambiguous, but
linguistics can solve them. When the context does not suffice, the user inter-
venes.

READIRIS CHANGES LANGUAGES AS NEEDED

But the buck doesn't stop here: Readiris can switch languages in the middle of
a sentence without any help from the user! When Western words pop up in
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Greek, Cyrillic or Asian documents - many untranscrible proper names, brand
names etc. are written using the familiar Western symbols -, Readiris can switch
to the correct alphabet automatically. In other words, you can activate a mixed
alphabet of Greek, Cyrillic or Asian and Western characters.

Be sure to select "Greek-English" or the appropriate Cyrillic language setting
- for instance "Byelorussian-English". In other words: don’t try to just select
"Greek" or "Byelorussian" as document language and hope that the Western sym-
bols will come out fine!

        

Here’s an example where a Russian text contains some English words - open
the image file ALPHABET.TIF if you want to try it for yourself!
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The end result looks like this when opened with the wordprocessor - you may
have to select a Cyrillic font to display the Russian text correctly.
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To mix other languages, simply select the language with the most extended
character set. If you have a document where the, say, French translation is placed
alongside an English text, you have to select French as language to ensure that
the accentuated characters such as ç, é and ù get recognized correctly.

DEFINING THE DOCUMENT CHARACTERISTICS

Now that the language is set, we’ll turn to the other document characteristics.
You can fine-tune the recognition by specifying some document features: the font
type and character pitch. (These commands do not apply to Asian documents.)
Let’s clarify what this means.

First of all, indicate whether you are recognizing “normal” or dot matrix
printed documents with the command "Font Type" under the "Settings" menu.
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Setting this parameter correctly is mandatory: “draft” or “9 pin” dot matrix
symbols are made up of isolated, separate dots, and highly specialized recognition
routines are required to recognize them.

“Letter quality” dot matrix printing, also called “25 pin” or “NLQ” dot matrix,
requires the normal setting, as do the printing qualities typeset, typewritten,
laser printed and inkjet printed. Obviously, "Normal" is the default value.

The font type is indicated in the tooltip of the "Recognize" button: when no
message is added to the tooltip, the “normal” printing quality applies, when the
message "Dot Matrix" shows up in the tooltip, the dot matrix reading mode is
enabled.

The character pitch can be set with the command "Character Pitch" under
the "Settings" menu.

With fixed or “monospaced” fonts, all symbols of the font have the same
width. An "i" takes up as much horizontal space on a line as a
"w", as is the case in this sentence. Think of documents produced
using a typewriter, where the carriage moves a fixed distance for each typed
symbol.

A proportional pitch means that the width of a character depends on its
shape. Symbols like “m” and “w” are wider, take more horizontal space on a line
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than the “thin” characters “l” or “j”. Virtually all books, magazines and newspa-
pers are printed in proportional pitch.

The simplest solution is to leave this option at all times on the default value
"Auto", which means that Readiris will detect the character pitch automatically.

READIRIS GETS MORE INTELLIGENT EACH TIME!

When the document language is selected and document characteristics are
set, you can click the "Recognize" button.

The OCR progress is indicated on-screen. You can click the "Stop" button to
abort the text recognition.

At the end of the recognition, Readiris enters the interactive learning phase
when the learning is enabled with the "Learn" button on the main toolbar. Interac-
tive learning is enabled by default.

(Interactive learning does not apply to Asian documents: learning does not
make sense for these languages which use thousands of different symbols - and
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you’d have to be able to enter the ideograms, not an easy task when using a
Western keyboard!)

      

Font training can substantially enhance the accuracy of the recognition sys-
tem. When the user tries to read distorted, defaced forms as are found in real
documents or stylized font shapes which Readiris does not recognize optimally,
training can overcome this temporary “failure”.

User learning is also used to train the system on special symbols which
Readiris is unable to recognize, such as mathematical and scientific symbols and
dingbats. Some examples: Readiris can be trained to recognize the "π" symbol as
"pi" or the dingbat "(" as "Tel". (However, the list of recognized symbols cannot
be extended with the symbols "π"and "("!)

The recognized text is displayed progressively and the system stops on doubt-
ful characters, or - if you are dealing with touching characters (“ligatures”) - on
doubtful character strings. They are always presented in their context, the doubt-
ful characters are highlighted. Unrecognized characters are represented by a
tilde (the "~" symbol).
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The first thing you should do is verify if you activated the correct font dictio-
nary and dictionary mode - these are always indicated in the title of the learning
window. If that is not the case, click the "Abort" button - the document image is
redisplayed with the zoning as was created -, enable the right font dictionary or
dictionary mode and run the OCR again. (The operation of font dictionaries will
be discussed shortly.)

If necessary, enter a character (or character string) for the incorrect or un-
known shape and click one of the following buttons.

Learn
You agree with the proposed solution or correct it. The program saves this

doubtful character in the font dictionary as “sure”, final. Future recognition will
no longer require your intervention, the shape is considered learnt once and for
all.

In the example above, the system stops on a soiled character, and we click
"Learn" to accept a shape which cannot be confused with other characters.
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Don't Learn
You agree with the proposed solution or correct it. The difference with the

"Learn" button is that the learnt symbol gets the status “unsure” in the dictionary.
For future recognition, the system will propose the learnt solution but still require
a confirmation.

This button is used for symbols which might be confused with others: a de-
faced "e" which might be mistaken for a "c", a damaged "t" which closely re-
sembles an "r" etc.

The "s" above is seriously damaged - in fact it is close to the "£" symbol -, and
you should click "Don't Learn" so as not to confuse it with the pound symbol.

Delete
The displayed form is eliminated from the output. This button is used to ignore

“noise” on the documents - spots, coffee stains etc. - which might get recognized
as points, comma’s and what have you -, and to erase any other unwanted sym-
bol.
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Undo
You go back to correct mistakes. You can undo the nine last decisions.

Finish
The learning process is aborted but the OCR continues in automatic mode. All

decisions by the system thereafter are accepted without user validation.

Click this button when you see that the recognition is highly accurate and does
not require detailled proofreading.

Don't confuse "Finish" with the "Abort" button: with "Abort", no output is gen-
erated and you start all over, with "Finish", the text is created, it just isn't proof-
read in detail!

THE ROLE OF FONT DICTIONARIES

The results of each training session are temporarily held in the computer’s
memory but can and should be stored in files called “dictionaries” for future use.

These font dictionaries should be loaded into memory when you want to rec-
ognize similar documents in order to make use of the extra intelligence they con-
tain; in this way, Readiris takes into account the intelligence stored in these font
libraries. You could say that Readiris gets more intelligence each time you use it!

How does this work? The operation of font dictionaries is controlled by the
"Learn" menu: you have to select a dictionary with the command "Font Dictio-
nary" and determine its mode of operation.
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Font dictionaries are limited to 500 shapes, and you are recommended to
create separate dictionaries for specific applications, for instance per type of
document. For clarity, you are recommended to give meaningful names to the
font dictionaries, for instance REPORT.DUS, PALATINO.DUS etc. Dictionar-
ies have the default extension *.DUS. Training no longer has effect when the
dictionary is full: the results of the learning are no longer held in memory or
written to a dictionary.

You can set the dictionary mode inside the command "Font Dictionary" or
directly under the "Learn" menu. Three dictionary modes are available: new,
append and read.
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By selecting "New Font Dictionary", you indicate that the training results will
be saved in a new dictionary. (If you select an existing dictionary, its contents will
be erased.)

The append mode indicates that the training results will be saved in an exist-
ing dictionary: the recognition makes use of the extra intelligence already con-
tained in the dictionary, and you add new font shapes to it. In simple terms, this
option allows you to build up a font dictionary in several steps.

(When you enter a filename for a new dictionary and activate the “append”
mode, an empty font dictionary is created and you complete it.)

With the last option, "Read Font Dictionary", the dictionary functions in read-
only mode: you make use of the dictionary without adding new font shapes to it.

Select the new mode when a single page is recognized. To recognize many
pages of the same type - pages with the same fonts and printing quality - select
the new mode for the first page, the append mode for a few pages more and the
read mode for the rest of the document(s).

Know that the tooltip of the "Learn" button indicates at all times which font
dictionary is currently active and in which mode that dictionary operates.
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When you enter the interactive learning, the dictionary and its operating mode
are indicated in the window title; you should click the "Abort" button and start
over in case they are wrong.

SENDING THE RESULT DIRECTLY TO YOUR APPLICATION

The interactive training concludes the character recognition. As Microsoft
Word operates as output target by default, your wordprocessor is started up au-
tomatically at the end of the recognition (if necessary) and the recognized text is
inserted.

You may get a progress bar on-screen as the recognized document gets for-
matted. (Whether this progress bar appears on-screen or not depends on the size
of the document and the complexity of the formatting to be performed.)
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The scanned image is displayed again with the zoning as created to be avail-
able for further processing, it stays there until you scan another page.

You have indeed converted a paper document into an editable computer file,
be it 30 times faster than manual retyping! Go ahead and compare it with the
image you have inside your Readiris window.

Actually, Readiris offers three different methods when it comes to saving the
OCR result: sending the recognized document directly to a target application,
saving the result in an external file and copying the result to the Windows clip-
board.

The output target is selected using the "Format" button on the main toolbar
(or the command "Text Format" under the "Settings" menu).
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The "Send to" feature offers a direct OCR link between your scanner and
your Windows applications: you send the scanned documents directly to your
wordprocessor or spreadsheet! Readiris exports recognized documents directly
to Microsoft Word 2000 and 97, to Microsoft Excel and the Windows accessory
WordPad.
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At the end of the recognition, the target application is started up and the rec-
ognized document is opened inside a new text file or worksheet.

Don't forget that the option "Send to" also allows you to copy the recognized
text to the Windows clipboard, so there is no strict need to export the result... or
save it to an external file!

SAVING THE RESULTS IN A TEXT FILE

You can indeed write the OCR result to an “external” file. Readiris supports a
wide range of file formats incorporating all popular wordprocessors and spread-
sheets - Microsoft Word (DOC), RTF and HTML etc.
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When you select the option "External File", you are prompted to save the
recognized text at the end of the recognition phase.
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You can create a new file and append an existing text file - that's why you
have an "Append" option. You could for instance add two scanned pages of text
to a study which you wrote yourself. If you append an existing file, be sure it isn't
currently open, because that will prevent you from writing to it!
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RECOGNIZING MULTIPLE PAGES

When you click "Save" to save the text or place it on the clipboard, some brief
statistics are given on the number of characters you've just read. (If you send
the recognized text to a target application, no statistics are given.)

After the OCR, the scanned image is redisplayed with the zoning as created
to be available for further processing.

You can now open the recognized text with your wordprocessor or text editor,
import it into your desktop publishing software or any other text-based applica-
tion. Go ahead and compare it with the image you have inside your Readiris
window.

But how do you save the text of additional pages? Or in other words: how do
you process documents consisting of multiple pages? It's actually very simple: go
on recognizing pages, but enable the option "Append" when you are saving to the
same file! Secondly, don't forget to put the font dictionary in the append mode so
that you can continue the font training comfortably.

As soon as you scan pages (or open image files) inside a document, you have
to decide whether you want to start a new document or complete the current
document.
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Answer "no" to add pages to the current document, answer "yes" to create a
new document. This answer has the same effect as the command "New Docu-
ment" under the "File" menu.

But there's a more efficient way of recognizing several pages than scanning
and OCRing them one after the other: processing multipage documents di-
rectly!

To scan a document composed of several pages in one operation, enable the
document feeder of your scanner with the option "ADF" under the "Scanner"
button.

       

Place the pages of your document in the automatic document feeder and start
the scanning: all pages are scanned until the document feeder is empty.

You can also open multiple prescanned images. To load several images, se-
lect the first image and hold down the Ctrl key as you select additional images. To
load a continuous range of images, select the first image and hold down the Shift
key as you select the last image.
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The same effect can be obtained comfortably from within the Windows Ex-
plorer: select several image files, right-click and select the command "Recognize"
from the "Context" menu. You can repeat this operation: all images you send to
Readiris append the current document until you click the command "New Docu-
ment".
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You can even drag several prescanned images from the Windows Explorer
onto the Readiris window! The same argument holds: all images you drag onto
the Readiris window are added to the current document until you click the com-
mand "New Document".

The page toolbar below the image - it is displayed as soon as pages get
processed - represents the various pages of the document and gives access to
the page commands (using the right-click).
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The current page is highlighted in the page toolbar and mentioned in the Readiris
title bar.

The page toolbar comes with a tooltip: hold your mouse pointer over a page
icon to learn which image was loaded into the memory. (If a multipage image
was opened, there's obviously just one file for all the images.) When you are
scanning multipage documents, the tooltip simply mentions the scanner model.

     

Load the sample image MULTIPAG.TIF and start the recognition. The vari-
ous pages are displayed one after the other; the Readiris title bar indicates the
page number.
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If the interactive learning is enabled, you go through the recognition and learn-
ing phases page by page. The dictionary mode "New" is used for the first page
and the mode "Append" for the successive pages.

When you click the "Finish" button, all decisions by the system thereafter are
accepted without user validation. In other words, the interactive learning is aborted
for all pages; the OCR for this document continues in automatic mode.
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The recognition result of multipage documents is saved in a single output file.
When the recognition result is sent to a target application, multiple pages get
created inside a single document.

EDITING MULTIPAGE DOCUMENTS

The user can edit multipage documents, mainly to correct scanning errors: he
can delete pages from the document and move pages to other locations in the
document.

The navigation first. To go to a page, click on its icon in the page toolbar or
hold your cursor over its icon, invoke the "Context" menu by right-clicking and
use the command "Select Page". To go to the previous page, you can use the
shortcut PageUp, to go to the next page, press PageDn. Or use the correspond-
ing commands under the "View" menu.

Let's edit the document now. To delete a page from the document, hold your
cursor over its icon, right-click it and use the command "Delete Page". To move
a page up in the document, use the command "Move Page Up", and to move a
page down, use the command "Move Page Down".

STARTING A NEW DOCUMENT

You can use the command "New Document" under the "File" menu to close
the current document.
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This command “cleans the slate”. Any document loaded into memory - con-
taining a single page or multiple pages - is erased. You are now ready to create a
new document.

But you can also create a new document from within the current document.
As long as the OCR was not executed, the system assumes that you want to add
pages to the current document. You can for instance scan all the pages in the
scanner's autofeeder, fill the feeder again and start over. All pages scanned will
compose a single document. Or you could scan a number of pages and add some
image files, say, faxes. These pages again form a single document, all you have to
do is change the image source in between with the "Source" button.

When the OCR was already executed and you re-initiate the scanning (or the
loading of images), you are prompted to start a new document or complete the
current document.

ORGANIZING THE TEXT OUTPUT

Saving or exporting the text means more than selecting an output method or
defining a filename for the output file. You also select a file format and determine
the appearance of the recognized text. In short, you have to decide where you
want to take the text before you launch the execution.

Some options of the "Format" button allow you to influence the look of the text
output.
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The text flow of the output document is directly influenced by the option
"Merge Lines into Paragraphs".

Keep this option enabled to have Readiris detect the paragraphs: Readiris will
then apply the normal wordwrap typical of wordprocessors, otherwise, a car-
riage return is added after each line and hyphenated words remain so! Paragraph
detection is enabled by default.

Let’s give an example to clear things up. When the first three lines of a col-
umn are "The new presi-", "dent waved from the balcony." and "His wife had
joined him.", the paragraph detection gives you the following result: "The new
president waved from the balcony. His wife had joined him." The hyphenated
parts of the word "president" were “reglued” and a space was added at the end
of the first sentence, thus creating naturally flowing text.

Had paragraph detection not been enabled, the original layout would have
been retained, with a carriage return added at the end of each line.

(The "Format" button contains some formatting options we haven't discussed
yet - this will be done shortly.)

SETTING UP YOUR SCANNER

Let's set our scanner up now. It is assumed that the scanner hardware and
necessary drivers are installed correctly.

If your Readiris software licence was bundled with a scanner model, this step
probably is unnecessary as your scanner may already be set up under Readiris.

Click the "Scanner" button on the main toolbar.
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Click the button "Scanner Model" to determine your scanner model.

When you select the option "<Image>" as “scanner”, prescanned images func-
tion as image source at all times - you won't have even to select the disk as image
source with the "Source" button on the main toolbar.

The "Config." button is only available when you scanner allows it. It gives
access to some advanced scanning parameters; with Twain scanners, clicking
the "Config." button allows you to select the Twain source. (You can also use the
command "Select Source" under the "File" menu.)
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Your scanner may also come with a scanning platform such as HP JetSuite
or HP Document Assistant. Depending on the software bundle you acquired, you
may find specialized manuals concerning the scanning platforms on the Readiris
CD-ROM.

Once the scanner is selected, the same window may allow you to set the
scanning resolution, the page format and orientation, brightness and contrast and
may allow you to indicate whether you are going to use the scanner's document
feeder. With Twain compliant scanners, all scanning parameters are often set
within the Twain interface.

Set the brightness, and, if available, the contrast. The contrast setting is
only available on some scanners. Drag the trackbar to darken or brighten the
document; the selected values are represented numerically.

Readiris supports black-and-white, greyscale and color images on an equal
basis, so you are free to choose the color mode that best suits your needs. To
include lineart graphics in the recognized documents, scan in black-and-white, to
include black-and-white photos, scan in greyscales, to include color pictures, scan
in color.

But why would you reduce the bit depth of the images during the scan? It goes
without saying that greyscale and color images are slower to acquire and require
more RAM memory than “bilevel” images.
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Scanning in greyscale and color isn't just useful to save the graphics with
sufficient quality, in some instances, it's also useful or necessary to obtain good
OCR results! When text is printed on a color background, scanning in color may
create the tone differences that are lacking in black-and-white images. When
there is only limited contrast between the text and the background, the back-
ground can create “noise” that renders the recognition difficult or impossible!

Think for instance of black text printed on a dark background: when scanning
such a document in black-and-white, you may not be able to “drop” the back-
ground color without losing the text information as well, as much as you may try
to adjust the scanner brightness...

          

Readiris creates a black-and-white version for every greyscale and color im-
age. Thanks to its intelligent routines, even tough cases get solved - here's how a
“difficult” image gets binarized!
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To view a scanned image in black-and-white, disable the option "Display Im-
age in Color" under the "View" menu.

Black-and-white images use a “fill” color to indicate the window type - yellow
for text zones, blue for graphics and purple for table windows. With greyscale
and color images, graphic windows have a blue border but no “fill” color - it
would be a shame to mask the actual color tones of the graphic.

Whatever your scanning mode may be, use a scanning resolution of 300 dpi
for normal applications. Use a higher resolution of 400 dpi for small print (below
10 point) and when the document is very degraded.

Readiris reads point sizes of 6 to 72 point (0.08 to 1" or 0.21 to 2.54 cm).

Readiris also recognizes “drop letters”, large caps that cover several lines.
(These can of course be no bigger than 72 point!)



2 - 52

By enabling the option "Landscape", you indicate that the selected page orien-
tation is wide (“landscape”) instead of tall (“portrait”). The page orientation actu-
ally applies to reduced page formats: on an A4 flatbed scanner, you can scan, say,
A5 pages (half that big) in portrait or landscape format, but you can obviously
only scan the full A4 surface in one direction!

Finally, the option "Invert" allows you to generate “inverted” images in the
black-and-white scanning mode - activate this option to process full pages with
white text on a black background.

SAVING DEFAULT SETTINGS

Set all scanning parameters correctly and click the command "Save Default
Settings" under the "File" menu to save the current settings as default settings for
future use.

Settings files contain more than the scanner settings: they also determine
whether you are going to use interactive learning, which font dictionary is used
(and its mode), which language and font type - for instance a normal, proportional
font - the documents have, which output mode is used - for instance send text to
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WordPad - etc. In short, all operational settings of Readiris are stored in the
settings files.

SAVING SPECIFIC SETTINGS

The default settings will obviously be used at each program startup, but you
can save specific settings as well to avoid having to redefine the operational
parameters. The commands "Save Settings" and "Load Settings" under the "File"
menu take care of this.

Let’s give an example: if you regularly have to OCR English documents with
a specific layout, you are recommended to create a settings file for this type of
document. You would then select "English" as the document language, load a
specific zoning template to avoid having to reapply the same windowing each
time, disable learning but activate a font dictionary in the “read” mode because
the same typefaces are used systematically etc.

If you are unsure what the current settings are, you don’t have to “plunge”
into every menu and command to discover what they are. You can use the com-
mand "Info" from the "File" menu to get an overview.
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SCANNING DOCUMENTS

Now that our scanner is set up, we want to get started scanning documents.
There are some elements you should be aware of.

First of all, pay some attention to lineskew. Although the page analysis and
recognition are skew-tolerant, it may become difficult to window and OCR a
page correctly when the skew is too significant. Limited lineskew (less than 0.5°)
can be ignored because the OCR accuracy does not suffer.

The option "Page Deskewing" under the "Settings" menu determines whether
pages which were scanned at an angle will be deskewed, straightened auto-
matically - limited lineskew gets ignored. This option is enabled by default.

When this option was erroneously disabled, use the "Deskew Page" button on
the image toolbar (and the command "Deskew Page" under the "Process" menu)
to “straighten” pages which were scanned at an angle.
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The deskewing takes a few seconds: the image is analyzed to detect the skew
angle - if any -, the color or greyscale image and its black-and-white version are
deskewed and the page analysis gets re-executed.

       

You can make good use of the image DESKEW.JPG in the Readiris folder if
you want to try it. Disable the option "Page Deskewing" first, otherwise the page
will be deskewed automatically even before it's displayed!
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You may also need to adjust the page orientation. Use the rotation tools on
the image toolbar. (Corresponding commands are found under the "View" menu.)

      



2 - 57

USER'S GUIDE

Three rotation directions are available: to the left, to the right and upside down.
Rotation also takes a few seconds as the image itself is updated, not just the
display on-screen.

ADJUSTING THE SCANNED IMAGES

As was already indicated, powerful intelligent routines automatically convert
color and greyscale images into black-and-white. Should this still be necessary,
the user can optimize the image further for the consecutive OCR process. Select
the command "Adjust Image" under the "Process" menu to do so.

When you access this command, the black-and-white version is displayed
automatically. (It's as if you disabled the option "Display Document in Color"!)
There are some complicated concepts here, and we need to discuss them in
detail.
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The option "Smoothen Color Image" renders greyscale and color images more
homogeneous by “flattening”, smoothing out relative differences in intensity. As
a result, a sharper contrast is created between the foreground - the text - and the
background - a color, artwork etc. We suggest that you leave this option enabled
at all times.

The brightness now. By “brightness”, we actually mean the black-and-white
threshold. The setting "Auto" determines the bilevel threshold automatically. Ap-
ply a different threshold when necessary by darkening or lightening the black-
and-white image: when you darken the image, more pixels become black in the
black-and-white version, when you lighten the image, less pixels become black in
the black-and-white version.

Note above all that no image adjustment is executed until you click the "Ap-
ply" button! By clicking "OK", you execute the adjustment and close the window.



2 - 59

USER'S GUIDE

Here's an example where we lightened the black-and-white image dramatically -
though admittedly not with OCR accuracy in mind!

The first two options concern color and greyscale images, the last one,
"Despeckle", exclusively concerns black-and-white images. “Despeckling” means
that the “parasite pixels” (also called “salt and pepper noise”) will be removed
from black-and-white images.

      

Be sure that you don't erase spots that are too big, otherwise you might start
erasing the dots on "i" etc., portions of dot matrix letters etc.!
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The best way of optimizing the images for the OCR process is this: place the
adjustment window where it doesn't prevent you from judging the image adjust-
ment you execute. Adapt the parameters - clicking "Apply" each time - until the
image is crisp and clear.

LETTING THE OCR WIZARD WORK FOR YOU

Let's get started capturing documents now. Instead of going through all the
parameters, we'll use the OCR wizard, a very comfortable way of recognizing
pages.

Click the "OCR Wizard" button on the main toolbar (or select the command
"OCR Wizard" under the "Process" menu).

      

The wizard guides you through the OCR process comfortably: answer a few
simple questions and you'll obtain quick and easy results with Readiris.
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Note that the OCR wizard starts running each time you start up Readiris; you
can avoid this by disabling the option "Enable Wizard on Startup" in the first
screen of the wizard (and with the equivalent option under the "Settings" menu).

RECOGNIZING PAGES AUTOMATICALLY

The OCR wizard is a semi-automatic way of recognizing pages. Readiris also
allows fully automatic recognition: instead of being taken through the parameters
step by step, we will now recognize a page immediately, without any interruption.

To replace the "OCR Wizard" button on the main toolbar by the "Auto" button,
disable the option "Enable Wizard on Toolbar" under the "Settings" menu.
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Select the scanner as image source with the "Source" button and click on the
"Auto" button or select the command "Automatic OCR" under the "Process"
menu.

       

Automatic OCR means that a page is successively scanned, windowed by
page analysis or a zoning template and recognized without interactive learning.
All you have to do is initiate the scanning and save the recognized text, the inter-
mediate steps are handled by Readiris.

READIRIS RECREATES YOUR DOCUMENT LAYOUT

Automatic recognition, which renders the recognition process automatic, should
not be confused with autoformatting! “Autoformatting” means that Readiris rec-
reates a facsimile copy of the scanned document: the word, paragraph and page
formatting of your original document are applied.

Similar typefaces (serif and sans serif, proportional and fixed, normal and
condensed) are used as in the source document, the point sizes and typestyles
(bold, italic and underlined) are maintained across the recognition. The tabs and
the alignment (left, centered, right and justified) of each text block are recreated.
The placement of columns, text blocks and graphics follows your original docu-
ment.

In other words, Readiris allows you to archive a true copy of your documents,
be it a editable and compact text file instead of a scanned image!

All this implies that the sorting of windows only partially applies when
“autoformatting” is used: you can include and exclude zones, but any re-ordering
of zones is simply ignored!

Here’s an example of how it works. To get acquainted with this feature, open
the image AUTOFORM.JPG which is found in your Readiris folder.
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Click the "Format" button on the main toolbar and choose to send the OCR
result to Microsoft Word or select the RTF (Rich Text Format) or Word (DOC)
format. Secondly, select "Recreate Source Document" as layout option. (The
option "Merge Lines into Paragraphs" is enabled by default to apply wordwrap
within the paragraphs.)
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Note that layout reconstruction is limited to the Word (DOC) and RTF format,
and to documents sent directly to Microsoft Word. On the plus side, the Word
(DOC) and RTF formats are widely used text formats that can be opened by any
popular wordprocessor.

Other, “poor” formats generating “plain” text such as ASCII, ANSI etc. do
not support advanced formatting codes and therefore cannot offer autoformat-
ting. Similarly, the target application WordPad is a “reduced” text editor, not a
fully featured wordprocessor; WordPad may open RTF files but ignores most
formatting codes such as text frames, alignment etc.

When the recognized text is opened using a wordprocessor, the text looks like
this without any intervention by the user.
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To see the effect correctly, you need to enable the “WYSIWIG” mode of
your wordprocessor, mostly called “page layout” mode. However, if you send the
recognized document directly to Microsoft Word, the page or print layout view is
activated automatically!
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In short, Readiris not only recognizes your texts, but can format them for you
as well. OCR isn't just text recognition anymore, it is becoming more and more
page or document recognition as well!

TEXT FORMATTING, PART 2

The other layout options are "Create Body Text" and "Retain Word and Para-
graph Formatting".

As the icon on the right side illustrates, creating body text means you create
a non-formatted, “running” text. The text will be captured, but its formatting is
entirely ignored. Use this option when you just need to recapture a text but not its
layout.

(Generating Asian text implies creating body text - you cannot apply
“autoformatting” or retain the word and paragraph formatting. Secondly, the num-
ber of file formats is reduced.)

The option "Retain Word and Paragraph Formatting" represents the middle
road: the word formatting - font type (serif - sans serif, proportional - fixed,
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normal - condensed), point size and typestyle (bold, italic and underlined) - is
retained across the recognition, and so is the paragraph formatting - the tabs
and the alignment (left, centered, right and justified).

Don't confuse this formatting option with “full” autoformatting: this option just
puts one paragraph after the other, it does not recreate columns or copy the
relative position of the various zones.

SAVING GRAPHICS SEPARATELY

In our example, the graphic was included in the recognized text; whether this
is the case depends on the formatting option "Include Graphics". Saving graphics
inside the text is only possible with “full” autoformatting -, not with “poor” text
formats such as ASCII, ANSI etc.

Still, with Readiris, you can save graphics without performing text recognition.
As Readiris generates black-and-white, greyscale and color images, you can
capture lineart graphics and photos.

How? Draw a graphic zone around the illustrations, cartoons etc. you need.
Creating graphic windows manually is done in the same way as drawing text and
table windows, simply select the "Graphic Window" tool now.
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(Similar to the other window types, the tooltip of the graphic window tool tells
you how many graphic windows there are. And you can press the Alt key while
you select a window to display its type and its coordinates.)

Next, choose the command "Save Graphics" under the "File" menu.

You are prompted to specify a filename.

Determine which graphic file format you will use. Select a format that's sup-
ported by your paint or photo retouching software. The JPEG, TIFF and Paint-
brush (PCX) formats are available. (Graphic files can always be opened with the
Windows accessories Paint and Imaging.) Enable the option "Greyscale/Color"
to save the graphic as a color or greyscale graphic - this option is enabled by
default.
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The graphics are saved in a single file. You don't have to limit yourself to a
single graphic, but if you draw several graphic windows, they will be collected,
“stacked” in a single file. (You can use the "Crop" command of your paint or
photo retouching program to separate them.)

Sides smaller than 1 mm are not allowed - bitmaps of that size hardly contain
any information. “Irregular”, non-rectangular windows are invisibly converted
into rectangles: Readiris covers the maximal surface based on the largest coordi-
nates. In the example below, the graphic window with the black border is com-
pleted by the shaded area.
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READING FAXES AND DEFERRED RECOGNITION

Saving images as image files opens another possibility: you can save the full
page and perform deferred OCR on it later on. That's what we did with the
prescanned images of our tutorials.

Simply scan the document. Select the command "Save Full Page as Image"
under the "File" menu to save a single page. You'll again be prompted to save the
entire page as TIFF or Paintbrush (PCX) file.

Select the command "Save All Pages as Image" to save a multipage docu-
ment. A single file format is available here: (multipage) TIFF.

You can now select the disk as image source and open the image file with the
"Open" button (or with the corresponding command under the "Process" menu).
(If you use the "Open" command under the "File" menu, you don't even have to
update the image source.)

As color, greyscale and black-and-white images are supported on an equal
basis, Readiris opens JPEG images, Paintbrush (PCX) images, TIFF images
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(uncompressed, PackBits, Group 3 and Group 4 compressed), multipage TIFF
images and Windows bitmaps (BMP).

This capability is particularly useful to convert your faxes into editable text
files! If you have any influence over your correspondents, ask them to send faxes
with the “fine” quality - those faxes have the higher resolution of 200 dpi and will
yield better OCR results.

Don't forget that you can right-click on images in the Windows Explorer and
select the command "Recognize" from the "Context" menu to open images! Al-
ternatively, you can use “drag and drop”: drop image files from the Windows
Explorer onto the image zone of Readiris and they are promptly opened.

RECOGNIZING TABLES

So far, we've recognized texts and faxes and we've saved graphics. Let's
process a table now. Take a table of figures and scan it, or open the sample image
TABLE.JPG in your Readiris folder.

Actually, the image TABLE.JPG contains two tables, and that's no coinci-
dence! The page analysis zones them as table windows, and Readiris will recon-
struct them for you by recreating the tables cell by cell in your spreadsheet or by
inserting a table object inside your wordprocessor files.

Let's explore the different solutions, starting with the “gridded” or “framed”
table - it has borders around the cells.
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Run the recognition with the layout option "Retain Word and Paragraph For-
matting" or "Recreate Source Document" enabled and the table gets recreated.
Open your wordprocessor to have a look at the result. (You could obviously have
included the text paragraphs in the text file as well.)
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Now the “ungridded” example - it has no borders around the cells. Note that
the page analysis nevertheless detects the table!
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For optimal OCR accuracy, you should limit recognition to the numeric sym-
bols with the "Language" button. (The numeric mode is not strictly numeric, it
includes the symbols 0 to 9, +, *, /, %, , (comma), . (dot), (, ), -, =, $ and £.)

As you can only do this when the table doesn't contain any alphabetic symbols
- otherwise the text portions won't be recognized correctly - we can activate the
numeric mode now but couldn't do it for the first table.

This time, we will send the OCR result directly to the spreadsheet Microsoft
Excel, so we select Excel as target application under the "Format" button.
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The spreadsheet is started up automatically and the result looks like this: the
typical table structure with rows and columns is recreated, and you are immedi-
ately ready to process the data.

Also note that you can also send tables to the clipboard - hence the option
"Send to Clipboard Excel" - and save them in an external file - hence the file
format Excel (CSV stands for “comma delimited” data).

You may come across “ungridded” tables the page analysis does not detect as
table zones because the columns are too widely spaced - Readiris tries to avoid
confusion with columnized text blocks. To create a table window manually, click
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on the "Table Window" tool in the image toolbar and proceed as usual; the button's
tooltip again indicates the number of table windows.

THE “CONNECT” FEATURE, ANOTHER DIRECT LINK

Actually, there's yet another way of recognizing tables of figures: you can do
it from within your spreadsheet!

Similar to the "Send to" feature, which exports the reading result automati-
cally, the “Connect” feature offers a direct OCR link between your scanner and
your Windows applications. The only difference is the “inverse” way of proceed-
ing: you don't recognize your documents inside Readiris to export the result to a
“target” application, Readiris is called up from within your application!

As there are some manual steps no installation procedure can take care of
for you, you need to check the on-line help system or the file CONNREAD.DOC
in your Readiris folder to learn how to install it - it takes a macro to use the
“Connect” capability from within Word, Excel and WordPerfect. (That “Read
Me” file is displayed automatically at the end of the installation program.)
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When correctly installed, the “Connect” feature adds a new command to the
menus of your application. In the examples below, the command "Scan Text" is
added to the "File" menu of Word, and the menu "Scan Table" is added to the
menu bar of Excel.
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Here's how it works: Readiris may not run in the background when you launch
the “Connect” macro. Click on the new command in your application menu to run
Readiris. The “Connect” interface may ask you some questions before Readiris
will start running. Proceed as usual and quit the “Connect” interface when you
are through. The recognition results are inserted at the current cursor position.
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GETTING ON-LINE HELP

This concludes our overview of Readiris. Some last-minute information may
not be included in this manual. We thus recommend you to consult the on-line
help system for additional information on Readiris.

Go to the "Help" menu to do so. The command "Help Topics" and its shortcut
key F1 allow you to navigate through the many help topics.
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